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This Getting Results book provides you with information on how to install and

navigate RSLogix 5000.  The guide includes troubleshooting information and tips

on how to use RSLogix 5000 effectively.  It also explains how to access and

navigate the online help.

We assume that you are familiar with:

� IBM-compliant personal computers

� Microsoft Windows NT, version 4.0 with Service Pack 4.0

� Allen-Bradley Company’s Logix5550 controller

The Getting Results book can be considered the entry point into our

documentation set.  The documentation set contains pertinent, easily accessible

product information and ships with the software product.  The documentation set

is designed to free you from tedious paper shuffling and reduce information

overload.

The Getting Results book, online help, and the Online Books option make up the

RSI documentation set.

Online help

The online help includes all overview, procedural, screen, and reference

information for the product.  The help contains four basic components: overview

topics, quick start topics, step-by-step procedures, and screen element descriptions

(for example, text boxes, drop-down lists, and option buttons).
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Online Books

For our more complex products, we provide you with online documentation that

you can elect to install when you install the RSLogix 5000 software.  This

documentation includes all reference guides (such as programmer’s guides and

code reference guides) in an electronic format that you can access from the Help

menu.  Using the Online Books option allows you to get instant access to the

information you need.

The conventions used throughout this document for the user interface comply

with those recommended by Microsoft.  If you are not familiar with the Microsoft

Windows user interface, we recommend that you read the documentation supplied

with the operating system you are using before attempting to use this software.

Please use the feedback form, which you will find packaged with your software, to

report errors and/or let us know what information you would like to see added in

future editions of this document.
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This chapter includes the following information:

� Welcome to RSLogix 5000™

� Quick Start steps

� Navigating the software

With the RSLogix 5000 Logix programming software package, you need only one

programming software for sequential, process, drive, and motion control

programming.  The RSLogix 5000 software package provides you both symbolic

programming with structures and arrays for increased productivity, and an

instruction set that serves all of these types of applications.

RSLogix 5000 is designed to work with Rockwell Automation's Logix Platforms

and the Logix5000 family of controllers.  RSLogix 5000 functionality includes:

� ease of configuration, including a graphical controller organizer, I/O

configuration dialogs, a motion configuration tool, and point-and-click

methods of configuration

� sophisticated data handling, using both arrays and user-defined structures, to

provide the flexibility necessary for the application rather than forcing it to fit

the particular memory structure as defined by the controller’s data table

memory

� easy-to-use I/O addressing methods

Chapter
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� a free-form ladder editor that allows you to modify multiple rungs of logic

simultaneously, as well as to enter logic either from the point-and-click

interface or via an ASCII entry prompt

� a flexible, easy-to-use function block diagram editor that allows you to program

your logic via function blocks

� drag-and-drop editing and navigation to quickly move data elements from one

data file to another, rungs from one subroutine or project to another, or

instructions from rung to rung or function block diagram to function block

diagram within a project

� an instruction set that includes motion, relay ladder, and function block

instructions

� logical application organization, using task, program, and routine structures

� diagnostic monitoring capability, including a status display of the current

controller state, a program verification feature, and a robust data monitor

� highly integrated motion support
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To navigate through the various windows and toolbars in RSLogix 5000 more

easily, you should understand what they contain and what functionality each

provides.

When you open a project in RSLogix 5000, you can expect to see:

� The Menu bar - Select functionality from the menus that appear as you click

each selection on this bar.

� The Create Component toolbar - Use this toolbar to create new project

components (e.g., tags, routines, programs, etc.).

� The Online bar - This toolbar displays program and controller status.  This

toolbar indicates the operational mode as well as whether there are edits

present.

� The Common Logic toolbar - This toolbar contains all ladder logic items that

are not instructions (e.g., rungs, branches), as well as the most commonly used

instructions.

� The Standard toolbar - This toolbar contains many functions, (e.g., cut, copy,

paste) that you will use repeatedly as you develop and test your logic program.

Menu bar

Online bar

Common Logic toolbar

Controller Organizer

Status bar

Results window

View pane

Tabbed Instruction
toolbarLadder Edit toolbar

Standard toolbar

Create Component toolbar
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� The Ladder Edit toolbar - This toolbar contains all of the online editing

functions, as well as some common editing functions.

� The Tabbed Instruction toolbar - This toolbar displays instruction mnemonics

in tabbed categories.  When you click on a category tab, the instruction toolbar

just above it changes to show that category of instructions.  Click on an

instruction to insert it in your ladder program.

� The status bar - Look at the status bar for ongoing status information or

prompts as you use the software.

� The Controller Organizer - The Controller Organizer is a graphical

representation of the contents of your controller project.

� The View pane - The main window of the RSLogix 5000 software provides you

with a framework in which you can view various editors (e.g., the Ladder

Editor, Tag Editor, Data Type Editor, etc.).

You can increase the amount of space you have for editor windows by hiding

the Controller Organizer (View > Controller Organizer or Alt + 0) and the

Results window (View > Results or Alt + 1).

� The Results window - The Results window appears at the bottom of the main

RSLogix 5000 window after you have performed an operation that yields

multiple results or errors.  This window provides you with error and status

information on an operation as it executes.

This window consists of two tabs:

� The Error Tab - If you perform an operation that results in an error, the

error is highlighted in the Results window.

� The Search Tab - When you use the Find All and Replace All functions, the

find and replace results are written to the Search tab.

TIP If you want to know what any of the icons represent, simply move
your cursor over the icon.  A floating tooltip will appear and tell you
what the icon is used for.
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The following steps explain how to get up and running quickly with RSLogix 5000

as soon as you install it.

Step 1  �  Create a Project

RSLogix 5000 is based on projects, which are complete sets of files associated with

your controller’s programming and configuration.  Follow these steps to create a

new project.

1.  From the File menu, choose New.

The New Controller dialog appears.

2.  From the Type pull-down menu, choose the controller type that you wish to

use for this project.

3.  Enter the name you wish to use for the new project.

The name you enter here will be used to create the project file; the .acd

extension will automatically be appended to this name (i.e., you do not need to

enter it).

4.  Enter a description of the controller.
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5.  Choose the appropriate chassis type in which the controller will reside.

Note:  This field is disabled if you have chosen a FlexLogix controller type.

FlexLogix does not have a physical chassis, and therefore you do not need to

select a chassis type.

6.  Enter the slot number for this controller.

In ControlLogix, controllers occupy a numbered slot in the chassis and can be

placed in any slots.  It is also possible to place multiple controllers in the same

chassis.

For FlexLogix, since there is no physical chassis, this field is disabled, and slot

number 0 is displayed.

7.  Enter the appropriate revision information for your controller.

This field defaults to the latest revision for the given controller type.  For

FlexLogix, this field is disabled.

8.  Enter the directory in which you want to store the project file.

The directory defaults to the one you configured in the Workstation Options

dialog.  If you want to use a different directory, type its path or click on the

Browse button to find the directory.

The project file is created in this directory with the same name as the controller,

with a .ACD file extension.  For example, if your controller name is Oven1, the

project file name will be Oven1.ACD.

9.  Click on OK to create the project.

Once the project file is created, you will see the Controller Organizer, which

shows everything in the controller.

The default configuration contains a continuous task, called MainTask.  The

Main Task contains a program called MainProgram.  The Main Program

contains a routine called MainRoutine, which is configured as the main routine.

In addition, if you have chosen a FlexLogix controller, two FlexBus 1794

virtual backplane adapters are created in slots 3 and 4 under the I/O

Configuration folder.  These two folders will contain all local I/O for

FlexLogix, other than the two local slots for communication.  The first folder

contains all the I/O configured on the local Flex rail housing the Flex

controller; the second folder contains all I/O configured for the local non-

controller rail.
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Step 2  �  Configure the Controller

Follow these steps to configure the controller.  For this Quick Start, most of the

default settings will be useful for you.

1.  From the Edit menu, choose Controller Properties.

The Controller Properties dialog appears, with the General tab selected.

This dialog contains the information you provided in the New Controller

dialog.  You can make any changes you wish to the general controller

properties here, or proceed to Step 2.

2.  Click on the Date/Time tab to configure the controller’s wall clock time and

the coordinated system time status.

Note:  You can only configure the wall clock time while you are online.

3.  Click on the Serial Port tab to configure the controller’s serial port.
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4.  Click on the System Protocol tab to configure the controller’s serial port for

DF1 Point to Point, DF1 Master, or DF1 Slave.

Select the protocol you would like to use from the drop-down list.  Configure

other parameters on this tab according to the protocol you choose.

5.  Click on the Advanced tab to configure advanced controller properties such as

system fault program, power-up handler program, and system overhead time

slice.

If you are online, you can also view controller memory usage statistics from this

tab.

6.  Click on the File tab to view information about the project file.

Note:  This tab is informational only; you cannot edit any of the attributes

shown here.

7.  Click on the OK button to accept your configuration and close the Controller

Properties dialog.
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Step 3  �  Create and Configure I/O

Follow these steps to create and configure inputs and outputs.  In RSLogix 5000,

you must manually add all I/O and Communications modules.

1.  Right click on the I/O Configuration Folder in the Controller Organizer, and

choose New Module.

The Select Module Type dialog appears.

2.  Choose the module type you want to create and click on OK.

The Create Module wizard leads you through a series of dialogs from which

you can complete the process of creating and configuring the I/O module.

3.  Enter the configuration information for the module you are creating.

You must enter the name of the module and the current slot number where the

module resides.
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4.  Click the Finish button when you’re done entering information in the Create

wizard.

Step 4  �  Enter Tags and Aliases

Follow these steps to enter tags and aliases.

1.  Right click on the Controller Tags folder in the Controller Organizer and

choose Edit Tags.

The Tag Editor appears.  At this point, the Editor will be empty, since you

have not created any tags yet.

2.  In the create tag row, indicated by an asterisk (*), enter the name of the tag in

the Tag Name column.

3.  Enter a description of the tag, if desired.

4.  To create a base tag, enter the tag data type.

5.  To create an alias tag, enter the tag to which the new tag refers.

TIP You can create new tags from the New Tag dialog (choose New
Component > Tag from the File menu).  If you create a new tag
using this approach and you choose data types AXIS, MOTION
GROUP, MESSAGE, or PID, the Configure button will be enabled.
Click on this button to access a wizard that will lead you through the
configuration of these data types.

6.  Select the scope for the tag from the pull-down menu, if desired.

All tags are controller scoped by default.

7.  Select the style in which you want to display the value of the tag (e.g., Hex,

Binary, etc.).

Based on the data type you selected, a default style is chosen automatically.
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8.  Press Enter.

This moves the current cell to the next row, which creates a new tag.  If there is

any error in your tag definition, you will be prompted.

TIP If you have already defined the I/O modules, RSLogix 5000
automatically added tags for these modules.  All I/O tags are
controller scoped.

TIP The background color of a cell indicates whether the cell is read only
or not.  A white background indicates that the cell is modifiable; gray
indicates that the cell is read only.

Step 5  �  Enter Ladder Logic

Follow these steps to enter the ladder logic you will use to define your programs

and routines.

1.  Right click on the Main Routine icon in the Controller Organizer and choose

Open.

The RSLogix 5000 software opens the Ladder Editor Routine window.  If the

ladder routine is empty, RSLogix 5000 automatically adds the first rung.

2.  From the Ladder Instruction toolbar, click on the tab corresponding to the

instruction group from which you want to add an instruction.

3.  Select the desired instruction and drag it into the ladder editor routine view.

The instruction is added to the rung or branch on which you chose to put it.

4.  Modify the instruction as necessary..

Use the Tag Browser to define the corresponding tag.

5.  Use the Ladder Instruction toolbar to add additional rungs, branches, branch

levels, or instructions as required by your routine.

6.  Right mouse click on the routine tab and choose Verify Routine.

Any errors in your rung will be sent to the Results window .

7.  Make the necessary modifications to your rung.

8.  Right mouse click and choose Accept Pending Rung Edit.

Note:  This is only required if you are online.  You do not need to do this

when you are offline unless you have a pending rung edit you created while

online.
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If you are online, the Accept Pending Rung Edit command transfers the rung

to the controller, but does not execute it if you are in Run mode.  Any errors in

your rung are sent to the Results window.

Step 6  �  Download

Follow these steps to download your project to the controller.

1.  From the Communications menu, choose Who Active.

The Who Active dialog appears, from which you can select a communications

path to the controller.  If RSLinx is not already running, it is launched so that

you can view the network topology.

2.  Select the controller from the tree.

3.  Click on the Recent button to navigate to the Select Recent Communications

Path dialog, from which you can choose a communications path from among

the most recent paths stored on this workstation.

4.  Click on Download.

You are prompted to confirm that you wish to complete the download

procedure.  Since you have already configured your communications path, the

download works immediately, and your project is downloaded to the controller.

Download status and compiler messages appear in the status bar .

TIP The controller must be in Program or Remote Program mode before
you  can download the project.
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Step 7  �  Monitor Tags

Follow these steps to monitor your tags and the values you have assigned to them.

1.  Switch the controller to Run mode.

2.  Double click on the Controller Tags folder in the Controller Organizer.

The data monitor appears, and provides you with a means for viewing the

values assigned to specific tags.  This includes the status of your I/O modules.

You can view:

� Tag Name (read only)

� Value

� Force Mask

� Style

� Type (read only)

� Description

TIP The background color of a cell indicates whether the cell is read only
or not.  A white background indicates that the cell is modifiable; gray
indicates that the cell is read only.
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Step 8  �  Monitor Logic

Follow these steps to monitor your ladder logic as the controller executes your

routines.

1.  Switch the controller to Run mode.

2.  Double-click on the main routine to open the ladder editor.

You can view your ladder logic.  The rungs glow and values change as the

controller executes your routine.

To use RSLogix 5000 software effectively, your personal computer must meet the

following hardware and software requirements.

Hardware Requirements

The personal computer must have at least:

� a Pentium 90 MHz processor

� a minimum of 32 Mb RAM (we recommend 64 Mb)

� 40 Mb hard disk space free

� any Windows-compatible pointing device

Software Requirements

You must have installed these software products:

� The operating system must be Microsoft® Windows NT® 4.0, with Service

Pack 5. (RSLogix 5000 software does not support Windows NT 3.51, Windows

NT 3.50, Windows 95, nor Windows 3.x operating systems.)

� RSLinx communication software must be installed on the same computer on

which the RSLogix 5000 software will be installed.  Refer to the Release Notes

in the RSLogix 5000 online help for specific software version information, as

well as for compatibility information for various hardware and software

revisions.



Installing RSLogix 5000  �  15

After becoming familiar with the basic concepts of RSLogix 5000 software, you

are ready to install and start RSLogix 5000 software.

This chapter explains how to install RSLogix 5000 software

TIP After installing the RSLogix 5000 software, we recommend that you

read the RSLogix 5000 release notes located in the online help.  The

release notes may contain more up-to-date information than was

available when this document was printed.  To view the release notes,

start RSLogix 5000 software; then, click Help > Release Notes.

TIP When installing RSLogix 5000 software on a Windows NT 4.0

operating system, you must have Windows NT system administrator

privileges.  If you do not have these privileges, contact your system

administrator.

The RSLogix 5000 software package includes the RSLogix 5000 installation

program on CD-ROM.  Follow the instructions in this chapter to install the

software that you purchased.

Before you install RSLogix 5000

Keep the following considerations in mind before you install the RSLogix 5000

software:

� Be certain that no other copies of RSLogix 5000 are currently running, and be

sure to always uninstall earlier versions of the software.

� Be certain that RSLinx is installed before installing RSLogix 5000, and make

sure that you have only one copy of DTL32.DLL on your system

Chapter
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� You must have Administrator privileges for Windows NT V4.0 on the machine

on which you are installing RSLogix 5000.  You do not need these privileges to

use the software once it is installed, but you will not be able to complete the

installation without them.

� We strongly recommend that you close all other applications before you install

RSLogix 5000.

Installing RSRSRSRSLogix 5000 software

The following section describes installing RSLogix 5000 software on the Windows

NT operating system.

1.  Start the PC.

2.  Start Windows NT 4.0, if it does not start automatically.

3.  Insert the RSLogix 5000 installation CD into your CD-ROM drive.

The CD-ROM should autostart.  If it does not, run ausetup.exe from the root

of the CD.

4.  Select Install RSLogix 5000.

During installation, if you already have a version of RSLogix 5000 installed on

your computer, you will be prompted to give the installation program

permission to uninstall the older version (if you have not already done so).

5.  Follow the directions that appear on your screen.

When prompted for a serial number, enter any sequence of characters, not

longer than 10 characters in length.  Press F1 if you need help.

6.  When prompted, click Yes to complete the activation of the software.

Follow the directions that appear on your screen.

7.  Click on Finish to complete the installation.

When the setup utility finishes, an entry for the RSLogix 5000 application

program appears in the program list in the Rockwell Software group.

8.  Remove the CD of the RSLogix 5000 installation from the CD-ROM drive

and store it in a safe place.
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To start RSLogix 5000 software on a PC that uses the Windows NT 4.0 operating

system, click Start and then select Programs > Rockwell Software > RSLogix

5000 > RSLogix 5000 from the menu.

TIP Remember to use the Help function from within the application if you

need help with a specific dialog or function.  Press [F1] or click the

Help button on a dialog, or select Help from the menu bar.

If RSLogix 5000 does not start up or run properly, keep the following in mind:

� Do you have the correct version of RSLinx software installed?  RSLinx

software provides communication between the controller and your personal

computer.  RSLogix 5000 requires RSLinx version 2.10 or later.

� Does your computer have enough memory?  Running RSLogix 5000 on

Microsoft Window NT 4.0 requires a minimum of 32 Mb of RAM.

� Is the activation key installed?

Troubleshooting Hints

If: Then:Then:Then:Then:

You see this message at the

end of a manual uninstallation:

“Uninstall completed. Some

elements could not be

removed. You should

manually remove items related

to the application.”

1. Manually delete the target directory with the

remaining files.

2. Remove the registry entries related to the shared

DLL with the registry editor. For information about

using the registry editor, see the help file.

Warning:  Using the registry editor incorrectly can cause

serious problems including reinstallation of Windows.

Use the registry editor at your own risk.

The registry values that remain look like the following:

C:\Program Files\Rockwell Software\RSLogix

5000\Bin\1756_DO_PG_1.dll

The registry values can be found under the following

registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\

Windows\CurrentVersion\SharedDLLs
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The installation or

uninstallation failed for any

reason, and cannot be

restarted

1. Using the registry editor, manually remove the

following keys in the Registry:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\

Windows\CurrentVersion\Uninstall\RS5000.exe

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\

Windows\CurrentVersion\AppPaths\RS5000.exe

HKEY_LOCAL_MACHINE\SOFTWARE\Rockwell

Software\RSLogix 5000

For information about using the registry editor, see the

help file.

Warning: Using the registry editor incorrectly can cause

serious problems including reinstallation of Windows.

Use the registry editor at your own risk.

2. Remove the target directory that was chosen during

the previous successful installation (if any).
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The RSLogix 5000 Controller Organizer uses the standard tree dialog interface to

display the many components that make up the Logix5550 controller.  This

graphical display illustrates the hierarchical relationship between tasks, programs,

and routines within a controller, as well as the I/O and network modules that

make up the control system.  This display consists of folders and their contents

that contain all of the information about the programs and data in the current

project.

In front of each folder, there is an icon containing a + sign or a - sign.  The + sign

indicates that the folder is closed.  Click on it to expand the tree display and display

the contents of the folder.  The - sign indicates that the folder is already open and

its contents are visible.
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Click the right mouse button to bring up many different, context-sensitive popup

menus.  Often, you will find that this is a shortcut to using menu options from the

menu bar.  Double-click on files in the Controller Organizer display to bring up

functional dialogs, from which you can enter parameters to accomplish relevant

tasks.

RSLogix 5000 software makes use of an I/O configuration wizard that walks you

through the process of configuring the highly functional ControlLogix modules.

Once configured, the I/O dialogs provide you with access to runtime diagnostic

information.

RSLogix 5000 provides both logic programming and motion support.  Motion

configuration wizards help you to configure your axes.  Motion support also

includes a built-in auto-tune function to reduce the overall setup time normally

required to configure a motion system.

RSLinx provides communications to the Logix5550 controller to provide program

download, program upload, online editing, and data-monitoring functionality.  Any

of the ControlLogix network modules or the RS232 interface on the front of the

controller provide local or remote access.

The current communications configuration is the configuration for the controller

to which you would like to connect.  The name of the RSLinx driver you select is

shown on the Online Toolbar.  You can configure the current communications

configuration by choosing Communications > Who Active to access the Who

Active dialog.  If you then click on Go Online, Upload, or Download and click on

Apply, you will save the selected communications path as the current path.  If you

want to save the current path to an open project file, check the Apply to Current

Project box, click on Apply, and then click on Cancel to close the Who Active

dialog.

When you open a project, the communications configuration stored with the

project becomes the current configuration.  If you create a project, the current

communications configuration will be stored with the project.  You will usually

want to change the configuration before downloading to a controller.  Use Who

Active dialog to change the configuration.
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The Controller Organizer uses the model of the tree structure to show you the

interrelationships of the data and programs within your controller.

Important components to be aware of are:

� tasks

� programs

� routines

Chapter



22  � Getting Results with RSLogix 5000

Tasks can be scheduled, edited, and controlled.  Each task can contain multiple

programs, status information, and configuration information.

The Logix5550 controller supports 32 separate tasks.  One task, the Main Task, is

always continuous; the other 31 tasks are periodic.  When you create a project, the

Main Task is already defined as a continuous task.

Once you create a task, there are other properties that you must configure, such as

how the programs within the task execute.  You can prioritize the tasks up to 15

levels:

� the continuous task has the lowest priority

� a task at a higher priority (i.e., lower priority number) pre-empts one at a lower

priority (i.e., higher priority number)

� tasks at the same priority execute on a time-slice basis at 1 ms intervals

Once you create a task, you can later change its descriptive information if you

wish.

Each program contains a local data area (referred to as program tags), main

executable routine, subroutines, and a fault routine.  The controller supports up to

32 programs.  The programs within a task execute from first to last.

When you create a project, the Main Program is already defined in the Main Task.

Once you create a program, you must then configure the main routine and,

optionally, a fault routine.  You can later change the program’s descriptive

information if you wish.

A routine is similar to a program file in the PLC-5 or SLC processor.  Each

program must have a main routine configured.  You can also specify a fault routine

and additional subroutines.  You can have as many routines per program as the

controller memory allows.

When you create a project, the Main Routine is already defined in the Main

Program.

Once you create a routine, you can later change its descriptive information.
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In the past, you developed your applications in such a way as to fit them within the

confines of your programmable controller’s data table.  The introduction of

RSLogix 5000 and the Logix5550 controller eliminates this restriction by providing

both arrays and user-defined structures.  This allows the data to be constructed to

meet the needs of your applications rather than forcing your applications to fit a

particular memory structure.

With RSLogix 5000, you can use symbolic tag names (up to 40 characters in

length) to assign data within a controller.  This functionality allows you to name

your data specifically for its function within the control program, while providing

self-documented logic.

Tag names can begin with an upper or lowercase letter (a through z), or an

underscore (_) character.  The remaining 39 characters can contain numbers (0

through 9), letters, or the underscore.

Data tag aliasing

You can create symbolic tag names to access individual pieces of data or to point

to another tag.  This allows you to take advantage of and reuse engineering

methods by creating logic using one set of tag names and then, at installation time,

pointing these tags to the actual I/O tags.  This allows you flexibility in designing

your programs, as well as allowing you to separate the electrical design and

program development processes.
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TIP You can automatically display the base tag of an alias tag by doing the

following:

From the Tools menu, choose Options to display the Workstation

Options dialog.  From there, click on the Ladder Display tab and check

Show Tag Alias Information.

Storage of symbolic names on the controller

All of the tag names you use are downloaded with the control program into the

Logix5550’s memory.  These tag names are then used at runtime to provide access

to the controller’s data.  Consequently, you no longer need to worry about the

physical location of data within the controller.  When the controller is uploaded, all

of the tag names are retrieved to provide a partially-documented program.

RSLogix 5000 provides the ability to create custom-defined structures to store and

handle data as a group.  These structures supplement the predefined structures

(e.g., Timers, Counters, PID, Message, etc.).  A user-defined structure can contain

any base data type (e.g., SINT, INT, DINT, BOOL, REAL) or structure (either

predefined or user-defined).  In addition, a single-dimensional array can be

included as a structure member.

To create a user-defined structure, right click on the User-Defined folder in the

Controller Organizer, and choose New Data Type.  The Data Type editor will

appear, from which you can define your new data type.

Many control programs require the ability to store blocks of information in tables

that can be traversed at runtime.  RSLogix 5000 supports this requirement by

providing the ability to create custom arrays with up to three separate dimensions

(i.e., row, column, and depth).  Individual cells within an array may contain any

base data type (e.g., SINT, INT, DINT, BOOL, REAL) or structure (either

predefined or user-defined).
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Traditionally, the data within a controller is scoped in such a way that all routines

have access to read and modify its contents.  This can hinder the creation of library

routines because of the collisions that can occur when two programs are placed in

the same application.

RSLogix 5000 solves this problem by providing both program and controller data

encapsulation.  Data created global to the controller is accessible by all logic within

a controller, much the same way that a data table was accessible in previous PLC

processors.  The program local data, however, is accessible only to the routines

within a single program.  The same tag name may appear in different programs as

local variables.

You can specify which scope you wish to view by selecting the scope from the

drop-down menu in the Tag Editor and/or Data Monitor.

Data can be shared between controllers via scheduled peer-to-peer connections.

When you design your application, you configure it to both produce global to

other controllers in the system via the backplane, or consume tags from other

controllers.  This allows you to be selective about which data is sent and received

by any controller.  Likewise, multiple controllers can connect to any data being

produced, thereby preventing the need to send multiple messages containing the

same data.

Addressing I/O information with the RSLogix 5000 and Logix5550 controller

eliminates the confusion often associated with typical programmable controller

systems.  Once you configure an I/O module, using the I/O Configuration

wizard, tags are created using a combination of the communications node name,

physical chassis slot number, I for input, O for output, and Data to reference the

data to and from an I/O module.

All of the module’s information, both data and status, is presented as a structure

with individual field names for each component.  This eliminates the struggle

associated with trying to figure out which bit, or byte represents which piece of

information coming from the module.  Using tag aliasing, real names can be tied to

any portion of an I/O tag, enabling you to document how the information is used.



26  � Getting Results with RSLogix 5000



Advanced ladder editing and function block concepts  �  27

This chapter provides information that you can use to make editing your ladder

logic easier, as well as providing information on using the Function Block editor.

To make your programming tasks faster, RSLogix 5000 allows you to map any

available alphabetic key (A-Z) on your computer keyboard to a ladder logic

programming instruction.

1.  From the Tools menu, choose Options.
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The Workstation Options dialog appears.

2.  Click on the Ladder Editor category.

The Change Ladder Editor Preferences screen appears.
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3.  Check the Enable Quick Key box, and then click on the Configure button.

The Quick Key Configuration dialog appears.

3.  Double-click on a free space in the instruction column or click on the Assign

Key button.
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The Ladder Element browser appears.

4.  Select the instruction to which you want to assign the quick key.

From now on, if the option to enable Quick Key mapping is turned on, when

you type the assigned key while in the ladder editor, the instruction is added to

your routine.

There are several different methods you can use to add instructions.  You can

enter an instruction by:

� manually typing it in

� dragging the tag name from the Tag Editor or from other instructions

� using copy and paste

TIP You can drag-and-drop rungs, branches, instructions, and addresses.

To drag-and-drop, position the mouse pointer over the item, click

and hold down the left mouse button and drag it to another location,

and then release the mouse button.  White boxes indicate valid

locations; green circles indicate the current drop location when

dropped.
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Add a branch

Click this icon on the instruction toolbar to place a branch in your ladder logic.  If

your cursor is on an instruction, the branch is placed immediately to the right of the

instruction.  If your cursor is on the rung number, the branch is placed first on the

rung.

Move a branch level

Click on the upper left corner of a branch to move the branch level to another

location in your ladder logic program

Expand a branch

Click the right leg of the branch, and then drag the leg to the right or left.  Valid

release points will be visible on the ladder display.

Nest a branch

Place the cursor at the upper left corner of a branch leg and click on the Add Branch

button to place another branch structure within the original branch structure

Parallel branch

Place the cursor at the bottom left corner of a branch leg and click on the Add

Branch Level button.

Copy branch level

Click on the left edge of the branch level you want to copy.  In the picture at the left,

this is the center level.  Then click Copy Branch Level in the right mouse menu.

Finally, click on a rung or instruction in your logic and click Paste from the right

mouse menu to insert the contents of the branch level.
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Copy entire branch structure

Select the right leg of the branch structure, and then click Copy in the right mouse

menu.  Finally, click on a rung or instruction in your logic and click Paste from the

right mouse menu to insert the branch structure

Delete a branch

Place the cursor on the right branch rail, click the right mouse button, and then

click Delete.  If you cut or delete a branch, all instructions on the branch are also

deleted.

Delete a branch level

Place the cursor on the left branch rail, click the right mouse button, and then click

Delete.  If you cut or delete a branch, all instructions on the branch are also

deleted.

The online editing function allows you to monitor and correct your ladder

program when you are connected to the Logix5550 controller.  When you are

editing an instruction’s tag value field and you commit your edits, the data value

change happens immediately for both online and offline editing.  When you are

online, this only happens to rungs that are in the controller.

TIP Operands whose values will change immediately when you commit your

edits are indicated by a blue arrow.

Within your logic program, RSLogix 5000 places zone markers in the margin to

the left of the left rail.  These letters signify edit zones, and they indicate the type

of ladder edits that exist in the routine.

Lower-case zone markers

Lower case zone markers indicate edits that exist only in the computer memory.

Once you successfully assemble the edited rungs, these zone markers disappear.
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Marker Description

e These rungs are currently under edit within the computer RAM.  If you are

working offline, after a successful routine verification, the lower-case e will

disappear and the edits will be incorporated into the routine.  If you are

working online, after accepting the rung, the lower-case e will be replaced

by an upper-case I, indicating that the rung is now in the controller’s

memory and will be inserted into the routine file.

i These rungs are to be inserted into the routine.  Rungs marked with a

lower-case i currently exist in the computer memory and will not be

entered into the controller until the rung is accepted.  After the rung is

accepted, the lower-case i is replaced by an upper-case I.  These rungs are

the same as e-marked rungs, but have already been verified.

r These rungs are to be replaced in the ladder routine.  Rungs marked with a

lower-case r are currently marked for replacement in computer memory,

but this marking will not be entered into the controller until the rung is

accepted.  An r-marked rung is always preceded by an e-marked or I-

marked rung.  After the rung is accepted, the lower-case r will be replaced

by an upper-case R.

Upper-case zone markers

Upper case zone markers indicate edits that exist in the controller memory.  Once

you successfully assemble the edited rungs, these zone markers disappear.

Marker Description

I These rungs have been inserted in the controller’s logic routine.  You can

test the edits by choosing the Test Edits option to see how the rung works

in the online ladder routine.  Choose Assemble Edits to finalize the rung

insertion and complete the editing process.

R These rungs have been replaced in the controller’s logic routine.  Rungs

marked with an upper-case R continue to function in the routine until you

select Test Edits to see how the new rung works in the online routine.

Choose Assemble Edits to finalize the replacement and complete the

editing process.

D These rungs have been deleted in the controller’s logic routine.  Rungs

marked with an upper-case D continue to function in the routine until you

select Test Edits to see how the routine functions without the rungs in the

online routine.  Choose Assemble Edits to finalize the deletion and

complete the editing process.



34  � Getting Results with RSLogix 5000

ASCII editing is a function of RSLogix 5000 that allows you to modify

instructions using ASCII instruction mnemonics instead of having to modify

instructions using the ladder editor.

To access the ASCII editor, simply double-click on a rung number in the left

margin.  If you double-click a rung that already contains logic, you will see the

mnemonics for the existing instructions and will be able to modify or add to them.

If you double-click on an empty rung, you get an empty editing box into which

you can type the mnemonics that represent the logic you want placed on the rung.

Note:  RSLogix 5000 also allows you to modify instructions using neutral text.

When you open a function block routine, it is displayed within the Function Block

Editor routine window.  This window appears within the main RSLogix 5000

screen.  It contains tabs for all open routines, a view for each routine, and a sheet

toolbar to help you work with the sheets within each routine.

The routine window components are described below.

Function Block Editor Title Bar

The title bar of the Function Block Editor routine window displays the scope of

the routine, followed by the routine name.  If the routine is a controller-scoped

routine, the word Controller appears; otherwise the name of the program to which

the routine is scoped appears.

Depending on the state of the routine, an additional character may appear in its

title.  For instance, a * indicates that the routine has been modified (i.e., it is

"dirty").

Sheet Toolbar

The sheet toolbar allows you to create, delete, or navigate between sheets of a

function block routine.
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Routine Tabs

The routine window contains a tab representing each open routine.  Each tab is

labeled with the name of the routine with which it is associated.  Position your

mouse over a tab to see a tooltip with the full name of the routine. If there are a

large number of routines open, the names are shortened.

To cycle through the tabs, press Ctrl + Page Up; Ctrl + Page Down allows you to

cycle through the tabs in the reverse direction.

Click the right mouse button on a tab to display a context-sensitive popup menu

that lists operations you can perform on the specified routine.

Routine View

The Routine View is the area inside the Function Block Editor window that

displays your function block diagram.  Each routine view can contain two view

panes of the routine, an upper pane and a lower pane.  You can adjust the height

of these panes. Each routine view and pane contain their own caret, scroll

positions, and zoom capability.

Routine Splitter

When a routine is initially displayed, its upper pane is not shown.  By using the

splitter bar, you can split the routine view in half, showing two separate panes of

the same view.  Simply drag the splitter bar up or down to move the bar, or choose

Split from the Window menu.  To position the splitter bar, drag the splitter bar up

or down, or select the Split option from the Window menu.

Note:  If you use the splitter to close the active pane, all editing operations in the

Function Block Editor will be disabled.

Note:  To toggle between different panes of a routine view, you can press F8.

Routine Scroll Bars

The routine window contains scroll bars that allow you to scroll the routine view’s

pane up, down, left, or right.  You can scroll this view by using the arrow keys, the

Page Up/Page Down keys, or the mouse.  In addition, RSLogix 5000 supports the

use of the Microsoft Intelli-Mouse.  By rotating the mouse wheel, the routine

window will scroll up or down.  If you hold down the Shift key, and rotate the

mouse wheel, the window will scroll left or right.
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RSLogix 5000 provides you with several means for monitoring and diagnosing

problems with your data and the controller you are accessing.

The standard RSLogix 5000 Online Bar contains a heads-up display of the current

state of the controller.  This status bar also provides you with shortcuts to

upload/download programs, change the controller’s mode, and other commonly-

used features.

RSLogix 5000 provides a logic verify feature that automatically scans the program

for errors that could prevent the application from being downloaded into the

controller.  When this verification takes place, the Results window displays a list of

errors along with their location within your application.
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When you double-click on an error code within the Results window, the logic

window is automatically moved to the location of the error, so that you can correct

it.  This verification and auto-navigation can save a great deal of time in your

program development process.

Note that while you can navigate to the source of an error by double-clicking (or

pressing Enter) on an error message, some errors (and all comments) may not

support any navigation.  In addition, some errors that do support navigation may

lose this ability, depending on your activities.  For example, if you edit a routine,

you might delete the rung an error message is referencing.  In that case, you would

no longer be able to navigate to the rung from the message.

The easiest way to inspect and fix your errors is to use the Next and Previous

Error menu items (F4 and Shift + F4).  You will see the error selected in the

Results window, and the editor or configuration window in which you can fix it

will be displayed.  If you choose Next Error and you are at the end of the list, you

will wrap to the first error in the list.  Likewise, if you choose Previous Error and

you are at the beginning of the list, you will wrap to the last error in the list.

If you want to inspect a specific error, then it may be easier to scroll to the error

and double-click on it.
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All of the tags used in a controller can be monitored in the data monitor.  This

monitor allows you to move through the list of tags in your controller to quickly

locate an individual tag.

You have the capability to sort this list by Alias For, Base Tag, Description, Style,

Tag Name, and Data Type to easily zero in on the data you need.  Once located,

you can selectively pick the method or radix (e.g., bit, num, octal, hex, ASCII) used

to display an individual tag.

You have the capability, as well, to filter the tags that are shown based on data

type.  This enables you to show only those tags that fit the data type you select.

Finally, you can also view tags by controller scope.  Note that you can only see one

scope at a time.
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Forcing allows you to override an I/O module's values in the controller.  Using the

Data Monitor or the Ladder Editor, you can manipulate forces on individual tag

elements.  From either of these, you can:

� force a tag element on or off (for tags of BOOL type only)

� remove the force from a tag element

If you want to manipulate all forces in the controller, you can use the Online bar

or the Forcing command from the Logic menu.  Once any tag element is forced,

the Online bar force status will indicate that forces exist in the controller, as well as

whether forces are enabled or disabled.  From this bar, you can also remove,

enable, or disable all forces in the controller.

To determine which tags are forceable , choose Forceable Tags from the Data

Monitor Show Filter.

Note:  You can only enable and/or disable forces at the controller level; you

cannot enable/disable forces only for a particular module, tag collection, or tag

element.
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Use this chapter to review the sources of additional information on RSLogix 5000

software.

You can find out more about RSLogix 5000 software by consulting:

� RSLogix 5000 online help

� ControlLogix Quick Tour online tutorial

� RSLogix 5000 training

� Technical support services

The RSLogix 5000 online help provides general overview information,

comprehensive step-by-step procedures, and control definitions. To view online

help while using RSLogix 5000 software:

� choose Help from the menu on the RSLogix 5000 main window

� click the Help button on any RSLogix 5000 dialog box

� press F1 on any instruction, dialog box, menu item, or window view
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Determining the next step

To view a list of tasks, open the Common RSLogix 5000 Procedures book on the

main Help Topics contents page.  From this area, you can jump to procedures

related to working with the RSLogix 5000 software.
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Finding definitions

Text highlighted with a dotted underline indicates a popup definition.  To display

the definition, click on the text highlighted with a dotted underline.  A popup

definition window will appear, providing you with the definition of the highlighted

term.

In addition, RSLogix 5000’s online help has an extensive Glossary which you can

access from the main Help Topics contents tab.
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From the main Help Topics contents tab, there is a Quick Start book that provides

you with Quick Start steps that can help you to get up and running quickly with

RSLogix 5000 software.  If you want more information about topics associated

with a major task, click on the specific procedure.

When you click a task, you jump to a How To window.  Follow the steps on the

How To window to quickly accomplish the identified task.  Then click on what

you want to do next from the list at the bottom of the How To window, as

appropriate.
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This version of the RSLogix 5000 software contains a link to an online tutorial that

you can run to learn about how to configure your ControlLogix system.  The

ControlLogix System Quick Tour is designed to give you an introduction to the

ControlLogix family of hardware, and the RSLogix 5000 programming software, in

addition to showing you how to use RSLinx to configure communications to the

Logix5550 processor.

This tutorial is designed to simulate a hands-on training session by leading you

through the same sequence of steps you will follow when you configure your own

ControlLogix system.

While you will not be working directly with the RSLogix 5000 and RSLinx

software packages as you go through this tutorial, the Quick Tour leads you

through the same sequence of screens and menus that you will see when you

launch those packages to set up your own systems.

To run the tutorial, choose ControlLogix Quick Tour from the RSLogix 5000

Help menu.

One of the best ways to increase your proficiency at using Rockwell Software

products is to attend a Rockwell Software training program.  Our training

programs can help you master the basics and show you how to unleash the full

potential of our software.

We offer a wide range of training programs, from regularly scheduled classes

conducted at Rockwell Software facilities, to custom-tailored classes conducted at

your enterprise.  The size of each class is kept small intentionally to maximize

student engagement.

If you would like more information about our training programs, visit the

Rockwell Software site on the world wide web or contact the Rockwell Software

Training Coordinator.  Our world wide web address and telephone numbers

appear on the inside front cover.
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If you cannot find answers to your questions in the Getting Results with RSLogix

5000 publication or in the online help, you can call Rockwell Software technical

support at the numbers listed on the inside front cover. The technical support staff

is available Monday through Friday from 8 A.M. to 5 P.M. Eastern Time, except

holidays.

When you call

When you call, you should be at the computer running the Rockwell Software

product and be prepared to provide the following information:

� product serial number on the Activation disk labels

You can find the serial number online.  On the RSLogix 5000 menu, click

Help, and then click About.

� product version number

This information also appears in the About box.

� hardware you are using

� exact wording/exact error codes of any messages that appear on the screen

� description of what happened, and what you were doing when the problem

occurred

� description of how you tried to solve the problem
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Use this appendix to gain a better understanding about Rockwell Software’s copy

protection.

Rockwell Software uses activation files to provide copy protection for its

Windows-based software packages.  These activation files reside on the Activation

disk. During installation, the software prompts you to insert the Activation disk

and move the activation key from the disk to the drive where you are installing

RSLogix 5000.

About the Activation disk

The RSLogix 5000 software package comes with a separate Activation key to

activate RSLogix 5000.  Without activation, RSLogix 5000 will not run.

The activation file contains:

� one or more activation keys

The activation key is the software that activates RSLogix 5000.  Depending on

your requirements, the Activation disk will have one or more activation keys.

For example, if your company purchases four RSLogix 5000 installations, you

require four activation keys.  Multiple copies of the same software require

activation keys with matching serial numbers.  All of the activation keys can be

on the same Activation disk.

� a file called EVMOVE.EXE that moves activation keys to and from computers

� a file called RESET.EXE that reactivates a damaged activation key

You can move activation keys off and on the Activation disk.  The files

EVMOVE.EXE and RESET.EXE always stay on the Activation disk.

Appendix
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Two methods for activating RSLogix 5000

Depending on your needs, you can activate RSLogix 5000 from a:

Diskette drive. Use this method if you will typically use RSLogix 5000 on more

than one computer—for example, if you want to run RSLogix 5000 on a desktop

computer and a portable computer.

Hard drive. Use this method if you will typically use RSLogix 5000 on only one

computer. This is the default method if you activate RSLogix 5000 during

installation. To run RSLogix 5000 on a different computer, move the activation

key back to the Activation disk, and then reactivate RSLogix 5000.

Using the Activation disk as an activation key

To use the activation key from a diskette drive, modify the ROCKSOFT.INI file so

that RSLogix 5000 searches the diskette drive for the activation key. Once you

modify this file, you must use the Activation disk each time you start RSLogix

5000.

To modify the ROCKSOFT.INI file

1.  Install RSLogix 5000 as described in chapter 2.

2.  When the Activation window opens, click Cancel to bypass the activation

procedure.

3.  In Windows NT 4.0, locate the directory where Windows is installed (for

example, C:\WINNT40).

4.  Open the ROCKSOFT.INI file.

5.  Locate the string that says: KEYDISK = FALSE.

6.  Edit this string so it says: KEYDISK = TRUE.

7.  Save and close the ROCKSOFT.INI file.

To activate RSLogix 5000

1.  Insert the Activation disk into the diskette drive.

2.  Start RSLogix 5000.

RSLogix 5000 automatically searches the diskette drive for the activation key.
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Moving activation keys back to the Activation disk

You can move activation keys from the hard drive back to the Activation disk at

any time. For example, you could move activation back to the Activation disk:

� to run RSLogix 5000 on a different computer

� before installing or using software that could damage the activation files (see

“Protecting your activation files” for a list of operations that can damage

activation)

� before sending the computer to be repaired

To move activation keys back to the Activation disk

1.  Insert the Activation disk in a diskette drive.

2.  In Windows NT 4.0, run A:\EVMOVE.EXE or B:\EVMOVE.EXE where A or B is

the drive containing the Activation disk.

3.  In the From box, select the drive where the activation key is currently stored.

In the To box, select the drive containing the Activation disk. Click OK.

4.  Do one of the following:

� To move activation keys for all installations, click Move.

� To change the number of activations to move to the Activation disk, select

RSLogix 5000, and then click the Edit Selected button. In the Move box,

type the number of activation keys to move. Click OK, and then click

Move.

5.  To close the EvMove Summary box, click OK.

Activating RSLogix 5000 after installation

You might need to reactivate RSLogix 5000 after moving activation keys back to

the Activation disk or after resetting a damaged activation key. To reactivate

RSLogix 5000, you move the activation key from the Activation disk back to the

hard drive.

By default, when you move activation to a hard drive from the Activation disk, the

software moves only one activation key for RSLogix 5000. However, when

moving to a network drive, the software moves all activation keys by default.

When reactivating RSLogix 5000, you can accept a default or choose the number

of activation keys to move.
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To reactivate RSLogix 5000

1.  Insert the Activation disk in a diskette drive.

2.  In Windows NT, run A:\EVMOVE.EXE or B:\EVMOVE.EXE where A or B is the

drive containing the Activation disk.

3.  In the From box, select the drive containing the Activation disk. In the To box,

select the drive where RSLogix 5000 is installed. Click OK.

4.  Do one of the following:

� To move the default number of activation keys, click Move.

� To change the number of activations to move, select RSLogix 5000 from

the list in the Source Drive box. Click the Edit Selected button. In the Move

box, type the number of activations to move. Click OK, and then click

Move.

5.  To close the EvMove Summary box, click OK.

Protecting your activation files

Performing certain operations on the hard drive can damage activation files.

Always move activation from the hard drive back to the Activation disk before

doing any of the following. After completing the operation, it is safe to move the

activation back to the hard drive and reactivate RSLogix 5000.

Move activation files back to the Activation disk before:

Upgrading or installing the computer’s operating system. Upgrading,

installing, and uninstalling operating system software or networking system

software can damage the Rockwell Software activation files.

Compressing or uncompressing the computer’s hard drive. Compressing the

hard drive with some compression software programs can damage activation

software. In addition, uncompressing a hard drive with activation files on the

compressed drive can damage activation.
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Reactivating a damaged activation key

If the activation key becomes damaged for any reason, visit our world wide web

site or call Rockwell Software Technical Support for a reset code. Our world wide

web address and telephone numbers appear on the inside front cover.

When you call

When you call or access the web space, you should be at a computer with the

Activation disk available. You do not have to use the same computer where

RSLogix 5000 is installed. However, you must have the Activation disk with a

serial number that matches the RSLogix 5000 software.

The support representative will explain how to find the product ID and system ID

from the Activation disk and then will assign a reset code for the activation key.

After obtaining a reset code from Rockwell Software Technical Support, reset the

key, and then reactivate RSLogix 5000.

To reactivate a key with a reset code

1.  Insert the Activation disk in a diskette drive.

2.  In Windows, run A:\RESET.EXE or B:\RESET.EXE where A or B is the drive

containing the Activation disk.

3.  In the Reset Code box, type the reset code, and then click OK.

4.  Reactivate RSLogix 5000.
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If activation is not working:

� Are you using the correct Activation disk? Check the serial numbers on the

RSLogix 5000 software and printed on the Activation disk labels—the serial

numbers must match.

� Does the computer have a virus? Boot sector viruses can damage the

Activation disk. The Rockwell Software support team recommends using a

commercial virus protection program.

� Did you save other files on the Activation disk? Saving any files to the

Activation disk can damage the activation software.

� Did you perform an operation on the hard drive that damaged the activation

software? See “Protecting your activation files” in this appendix.



Index  �  53
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on Activation disk, 47
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